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The New Power Point Interface 

PowerPoint is currently the most common software used for making visual aids for 

presentations. It has been redesigned for the 2007 release with a much more user-friendly 

and intuitive layout than its predecessors.  

This tutorial will teach you the basic tools for making a PowerPoint presentation and 

familiarize you with the new PowerPoint 2007 workspace.  

Getting started with Power Point 2007 you will notice that there are many similar features to 

previous versions.  You will also notice that there are many new features that you’ll be able to 

utilize.  There are three features that you should remember as you work within Power Point 2007:  

the Microsoft Office Button, the Quick Access Toolbar, and the Ribbon.  The function of these 

features will be more fully explored below. 
 

 

 

 



Microsoft Office Button 

The Microsoft Office Button performs many of the functions that were located in the File menu of 

older versions of Power Point.  This button allows you to create a new presentation, Open an existing 
presentation, save and save as, print, send, or close. 

                                            
 

Ribbon 

The ribbon is the panel at the top portion of the document   It has eight tabs:  Home, Insert, Design, 

Animations, Slide Show, Review, View and Add-ins.  Each tab is divided into groups.  The groups are 

logical collections of features designed to perform function that you will utilize in developing or 
editing your Power Point Presentation. 

 

 

Commonly utilized features are displayed on the Ribbon.  To view additional features within each 
group, click the arrow at the bottom right corner of each group. 

 

Home:  Clipboard, Slides, Fonts, Paragraph, Drawing, Editing 

Insert: Tables, Illustrations, Links, Text, Media Clips 

Design: Page Setup, Themes, Background 

Animations: Preview, Animation, Transition to this slide 

Slide Show:  Start Slide Show, Setup, Monitor 

Review:  Proofing, Comments, Protect 

View: Presentation Views, Show/Hide, Zoom, Color/Grayscale, Window, Macros 
Add-ins: Menu Commands, Toolbar Commands, Custom Toolbars 

 



 

Quick Access Toolbar 

The quick access toolbar is a customizable toolbar that contains commands that you may want to 

use.  You can place the quick access toolbar above or below the ribbon.  To change the location of 

the quick access toolbar, click on the arrow at the end of the toolbar and click Show Below the 
Ribbon. 

 

You can also add items to the quick access toolbar.  Right click on any item in the Office Button or 

the Ribbon and click Add to Quick Access Toolbar and a shortcut will be added. 

 

 
 

 

In PowerPoint 2007, you will find that tools with similar uses are organized so that they are 

usually found within the same Tool Group or at least within one Ribbon. If you do not find a 

tool in the Ribbon you think it should be in, try exploring the other Ribbon Tabs.  



 

  

Getting Started 

Create a new presentation 
 
 
 
 
 
 
 

Open an existing 
presentation 

 

 

Open a file from a different 

version or format 

MS Office Button >> New -- New Presentation window opens up 

  The MS Office Button is located in the top left corner of the  
 Word 2007 Window 
To start a new file from scratch: 

  Choose “Blank Document” and press “Create”. 
 

There are templates available on the left panel for creating a presentation of a 
specific type (ie. photo album or calendar). 

MS Office Button >> Open 

  Find your presentation in the “Open” window. 

  PowerPoint 2007 will open files created with older versions of PowerPoint  
 (*.ppt) as well as PowerPoint 2007 files (*.pptx) 

PowerPoint 2007 will automatically convert a document from a compatible 
version of PowerPoint 

   Your document will open in Compatibility Mode 

   This will prevent you from using certain tools in Office 2007 which are not  
 compatible with Office 2000 or 2003 

   When you finish editing a document, be VERY CAREFUL to save any  
 converted documents in their original format 

   Please read the Important Notes below regarding saving in Office 2007.  

IMPORTANT NOTES:  Saving Documents in PowerPoint 2007  

1.  In the Computing Facilities, files on the Desktop are NOT SAVED when you log off.  

   ALWAYS use Save As... to save your file to a USB Flash Drive, UVicTemp, or CD  

   You can also save a file to the Desktop and then email it to yourself with the file as an attachment  

2.  If you are NOT running Office 2007 at home and you save a document as PowerPoint 2007 (*.pptx), YOU  

 WILL NOT BE ABLE TO OPEN IT AT HOME! (see step 3 below)  

3.  If you have Office 2000 or 2003 or you use a Mac at home or in the Computing Facilities  

    You will have to save your document as an older version  

   Go to MS Office Button >> Save As  

o  At the bottom, there is a bar that asks you to “Save as Type:”  
 o  Choose PowerPoint 97-2003 Document (*.ppt)  
    DO NOT CHOOSE “PowerPoint Document (*.pptx)”  

 

4.  If you are using a PC at home running Office 2000 or 2003  

   You can download the MS Office 2007 to Office 2003 Compatibility Pack from Microsoft's website  

 o  http://www.microsoft.com/downloads/  

o  Under New Downloads, choose "Microsoft Office Compatibility Pack for Word..."  

   Even with the Compatibility Pack, you might lose data / formatting when you save as an older version    

There is no Compatibility Pack available for Mac yet. 

Save the current document 
 
 

Save a document under a  
different name, version, or  
format 

MS Office Button >> Save 

   Please read the Important Notes above regarding saving in  
 Office 2007 

MS Office Button >> Save As... 

   In the bars at the bottom of the Save As... sub window: 
o  Give your document a new name in “File Name:” 
o  Select the version and format from “Save as type:” 

   Please read the Important Notes above regarding saving in Office 2007  



 

  

Add a new slide Home Tab >> Slides >> New Slide 

   Click on New Slide button. It adds a new slide in the default layout "Title  

 and Content.”  

   Click on the arrow at the bottom corner of the New Slide button. You can  
 select the slide layout from the Default Design pallet.  

   Click Layout button. You can select and change the slide layout.    

Click Delete button to delete the current slides.  

 

Viewing Slides in PowerPoint 2007 Workspace  

View Tab 
 
 
 
 
 
 
 
 

Layout of frames in “Normal 
View” 
 
 
 
 
 
 
 

The View tab 
 

   Different views allow you  
 to manage different 

aspects of your 
presentation. 

 
 
 
 

Turn on/off visual guides 

 
 
 
 
 
 
 
 

When you first open a new presentation in PowerPoint the main window has 
three frames: 

   The right biggest frame shows the Current Slide. 

   The left frame has two tabs: 
o  Slides tab displays the slides as thumbnails 
o  Outline tab displays a written outline of each slide of your 

presentation. 

   The bottom frame is for Notes to remind you of points for each slide. 

View Tab >> Presentation Views 

Normal View - A window splits into Slide, Notes, and the left frame where you 
can choose either Slides Thumbnails or Slides Outline.  Allows you to focus on a 
slide and see everything about the slide at once. 
Slide Sorter - Gives thumbnails of all the slides in the presentation. Lets you 
see the big picture. Allows you to sort, move, add and delete slides easily. 
Useful near end of a project 
Notes Page - Displays a page layout of the notes and the slide. Allows you to 
rearrange the notes and compare them to the content of your slide. Slide Show 
- Plays the presentation from the beginning. 

View Tab>> Show/Hide >> Ruler 
 

View Tab>> Show/Hide >> Gridlines 

   Gridlines and rulers are used to measure and line up objects on a slide.  



 

  

Inserting and Formatting Text and Objects  

Insert Tab 
 
 
 
 
 
 
 
 

Add text with text boxes 
 
 
 
 
 
 

Move text box 
 
 
 
 
 
 
 
 
 

Format text box 
 
 
 
 
 
 
 
 
 
 
 
 
 

Format text in text box 
 
 
 

Add WordArt -- fancy text 

 
 
 
 
 
 
 
 

Home Tab >> Drawing >> Text Box 
In PowerPoint all text is contained in Text Boxes. 

   Click on Text Box button >> Click anywhere in the slide.  

   Drag circle corner points or square side points of the text box  

 to change its size. 

   Click within the box to type text. 

   Bring the cursor over the text box borders. 

   Cursor changes to the move icon (Cross with 
arrowheads).  Hold on the mouse and move the text 
box. 

   You can also Nudge a Text Box by selecting it and pressing the keyboard  
 arrow keys. 

   Rotate the text box: 
o  Bring the cursor over the green circle to rotate the text box.  

NOTE: You can move all the objects in a slide in the same way described  
above. 

 

 

 

 

 

 

 

 

   Select the text box. The Drawing Tools Tab appears.  

   Click on the Format tab. Format the selected text box in Shape Styles:  

 o  Shape Fill -- Changes the fill color 
o  Shape Outline -- Changes the color, width, line style of outline  
o  Shape Effects -- Applies visual effects (shadow, bevel, etc.)  to the text 

box 

   Select and highlight the text in the Text Box. 

   Click on the Home Tab 

   In the Font Group and Paragraph Group, you can format the Font, Size,  
 colour, and style of the selected text. 

Insert Tab >> Text >> WordArt 

   Click on the WordArt button >> Select the style you like    

A WordArt Text Box appears in the slide.Type in.  



 

 

Format WordArt 
 
 
 
 
 
 

Add shapes 
 
 
 

Format shapes 
 
 
 
 
 
 
 

Lay one shape over/under 
another 
 
 
 
 

Group, Align and Rotate 
shapes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Add an image from a file 
 

Add an image from Clip Art 

   Select the WordArt in the slide. 

   The Drawing Tools Tab will appear at the right end of the  
 Ribbon Tabs 

   Click on the Format Tab. 

   Format the selected WordArt in WordArt Styles Group. 
 

Insert Tab >> Illustration >> Shapes 

   Click on the Shape button to see the list of available shapes.    

Select the shape. 

   Click on anywhere in the slide to insert the selected shape.    

Select the shape.  Drawing Tools Tab appears 

   Click on Format tab.  Format the selected shape in Shape Styles:  
 o  Shape Fill -- Changes the fill color 

o  Shape Outline -- Changes the color, width, line style of outline  
o  Shape Effects -- Applies visual effects (shadow, bevel, etc.)  to the 

shapes 
NOTE: You can format the inserted shapes as you format "text box" using 
Drawing Tools Tab. See "Format text box" in the previous page. 

   Select the shape. 

   The Drawing Tools Tab will appear 

   Click on Format tab.  Arrange the order in the 
Arrange Group : 
o  Bring to front 
o  Send to back 

 
 
 
 
 
 
 
 
 

   While holding the shift key, click on the objects you wish to group.  
 Drawing Tools tab appears. 

   Click on Format tab. 

   To group the objects: Click on Group button in Arrange Group  

   To align the objects: Click on Align button in Arrange Group  

   To rotate the objects: Click on Rotate button in Arrange Group 
Shapes in a group my still be moved and edited individually, and will continue 
to correspond to their group after being changed. 

Insert Tab >> Illustrations >> Picture 

   Find the picture file you want to insert in the browser window. 

Insert Tab >> Illustrations >> Clip Art 

   Search for ClipArt and other media in the right-hand search panel.  

   Check in "Everywhere" box under "Search in" for more extensive results  



 

 

Format an image and Clip 
Art 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change the background 
 
 
 
 
 
 

Change the theme 

Formatting process is basically the same as formatting "text box," "WordArt," or 
"Shape." 

 

 

 

 

 

 

   Select objects (image or clip art).  Picture Tool Tab appears.  

   Format objects using Adjust Group, Picture Styles Group and Arrange 
Group. 

   Move objects: See the instruction of "Move Text Box" 

Formatting Slide Design 
Design Tab 

 
 
 
 
 
 

Design Tabs >> Background >> Background Styles 

   Click on  the Format Background  button at the bottom.    

Format Background window appears. 
o  You can set the color, solid or gradient, transparency or choose 

picture/texture fill 
o  Click on Close button to apply changes only to the current slide 
o  Click on Apply to All to apply changes to all the slide 

Design Tabs >> Themes 

   Move the cursor over the theme buttons to preview different themes on 
your current slide. 

   Click on any theme button to choose the theme, which will be applied to all 
the slides in your presentation. 

   Colors -- Changes the color scheme of the current theme    

Fonts -- Changes the font of the current theme 

   Effects -- Changes the effects of the current theme 

Formatting Presentation in Slide Master  
The Slide Master acts as a template for your entire presentation.  

Altering anything on the Slide Master will change it for all the slides in your presentation.  

View Tab  
 
 
 
 
 
 
 
 
 

Open the Slide Master View Tab >> Presentation Views >> Slide Master 
   Slide Master Tab appears on the left-hand side of Home Tab  



 

 

Edit the Slide Master 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Create custom animation 
effects for objects 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Modify Animation effects and 
order of animated objects 
 
 
 
 
 
 
 

Create a slide transition 

   Click on Slide Master Tab provides a set of Slide Master 
formatting groups: 

o  Edit Master 
o  Master Layout 
o  Edit Theme 
o  Background 
o  Page Setup 
o  Close -- Click on Close button to go back to Normal View. 

Objects and Animation 

Animation Tab 
 
 
 
 
 
 

Animation Tab >> Animations >> Custom Animation 
 

   Custom Animation panel appears on the 
right-hand side of the current slide. 

   Select the object you wish to apply animation 

   Click the Add Effect button and choose the 
animation style. 
o  Frequently-used effects are found in 

"Entrance" styles in the menu 

   Click the Play button to preview the 
animation. 

 
 
 
 

   Customize animation effects under Modify in Custom Animation panel.  
 o  Start -- how to start the animation 

o  Direction -- direction of animation 
o  Speed -- speed of animation 

 

   Change orders of animated objects: 
o  Select the object in the list under Modify 
o  Hold on the mouse and bring up or down to change the order of 

objects 

Slide transitions are animation effects that appear between slides. While they 
look fancy, these transitions can be distracting if overused. It is often good to 
keep this kind of animation to a minimum. 

Animation Tabs >> Animations >> Transition to This Slide  

   Mover the cursor over the transition buttons to preview the effects.  

   Click on the Transition effect button to apply the slide transition effect.  

   Click on Transition Sound button to apply sound effect for transition.  

   Click on Transition Speed button to adjust the speed.  

   Click on Apply to All to apply the same transition effect to all the slides.  



 

  

Finishing Steps 

Change the order of the 
slides 
 
 
 

Make notes 
 
 
 
 
 
 

Present the slide show 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Save a presentation 

   View Tab >> Presentation Views >> Slide Sorter 

o  You can easily change the order, if you have a lot of slides.    Or, 

select Slides tab in the left frame in the Normal View. You can see  

 thumbnails of the slides in your presentation. 
o  Click on a slide thumbnail and drag up and down to change the order. 

Write your notes in the bottom frame in Normal view. 

To Print your notes: 

   Office Button >> Print >> Print What: 

   Select "Note Pages" 

NOTE: Notes are not visible during the slide show. 

Manual Presentation: 
View Tab >> Presentation Views >> Slide Show 

To move to the next slide in your presentation do one of the following: 

   Click the left mouse button 
   Hit the spacebar 

   Use the arrow keys on the keyboard. Up and left go back, right and down  
 go forward. 

   Click on the Esc key on keyboard to go back to Normal view. 
 

Automatic Presentation: 

Animations Tab>> Transition to this Slide >> Advance Slide    

Click on the check box for "Automatically After." 
   Set the time to automatically change to the next slide after a certain  
 duration of time. 

   This feature is useful if you are under a time constraint or if you want to  
 present in a more movie-like style. 

MS Office Button >> Save As… 
 

In the lab, use Save As… to save your file to: 

   USB drive 

   UVicTemp (I:\ in My Computer) 

    You can also save the file to the desktop and attach it to an e-mail. 

Please read the Important Notes on page 3 
regarding saving in Office 2007 

 
Be sure to remember that any files saved to the desktop will be 

automatically deleted after you log off!  
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Thank you for attending our Microsoft Power Point Training 

If you need further assistant with your presentation visit or contact OIRE 

 

 


